Tabellen verknupfen ("joinen")

OpenSchoolMaps.ch — Freie Lernmaterialien zu freien Geodaten und Karten

1. Einleitung

Ziele

Die Ziele dieses Arbeitsblattes sind:

* Verstehen, was das Verknupfen ("Joinen") von zwei Tabellen ist und wie das mit QGIS geht.

* Die Beziehungen zwischen zwei Tabellen wie one-to-one, one-to-many und many-to-many
verstehen.

+ Einfache numerische Klassifizierungsalgorithmen kennen und wissen, wie und wann man diese
im Desktop-Programm QGIS einsetzen kann.

Voraussetzungen

Um das Arbeitsblatt durcharbeiten zu kénnen, brauch man folgende Dinge:

+ Software: QGIS (getestet mit QGIS 3.4, 64-bit).

* Internetzugang zum Herunterladen von Daten und zur eventuellen Installation von QGIS
(download).

+ Daten: Joining Tables Aufgabenblatt Daten.

In den Daten sollten folgende Dateien zu finden sein:

* World_Countries.gpkg
* C02_Readings.x1lsx
* Worldbank_Countries.x1lsx

* RenewableEnerqgy_Percentages.csv und RenewableEnergy_Percentages.dbf

Wenn du bisher noch keine Erfahrung mit QGIS hast, kannst du dir unsere
Arbeitsblatter auf OpenSchoolMaps zum Thema "Einfiuhrung in QGIS 3 and in
Geoinformationssysteme (GIS)" anschauen.

2. Einfuhrung

Strukturierte Daten werden in einer zusammengesetzten Datenstruktur modelliert. Strukturierte
Daten sind oft in Tabellen organisiert, d.h. in tabellarischer Form. In einem tabellarischen
Datenmodell gibt es Columns (auch bekannt als: Spalten, Felder, Attribute, Zellen) und Rows (auch


https://download.qgis.org
../../zips//Daten_JoiningTables.zip
https://openschoolmaps.ch/pages/materialien.html#einfuehrung-in-qgis-3-und-in-gis

bekannt als: Datensatze, Zeilen, Eintrage). Diese Spalten haben auch einen sogenannten Datentyp,
der den Inhalt der Spalte naher beschreibt.

Eine Adressliste ist ein gangiges Beispiel flr strukturierte Daten in tabellarischer Form, eine Tabelle,
die aus Spalten wie z.B. der Postleitzahl besteht, die vom Typ Ganzzahl ist (zumindest in einigen
Landern).

Im Gegensatz dazu gibt es unstrukturierte Daten, z.B. ein Fliestextdokument, das nicht wie eine
Tabelle organisiert ist (nur eine lange Zeichenkette).

Zwei Tabellen kénnen miteinander verknlpft werden, wenn beide mindestens eine Spalte enthalten,
welche ahnliche Daten enthalten. Diese Spalten werden auch als Key bezeichnet, die Beziehungen
zwischen verschiedenen Tabellen herstellen kdnnen. Bekannte Beispiele fir Keys sind Postleitzahlen
oder Autokennzeichen, da diese bereits in ihrer realen Form als eindeutige Identifikatoren dienen.
Die Tabellen kdnnen weiterhin getrennt voneinander geandert und angezeigt werden. Man stellen
sich das als einen Vertrag vor, der zwischen zwei Tabellen geschlossen wird. Eine Spalte in jeder der
beiden Tabellen gibt genau an, auf welche Zeile sie verweist. Wenn Daten aus einer Tabelle
abgerufen werden, liefert die verbundene Tabelle ihre Daten gemass diesem Vertrag.

Keys sind Bezeichner, die auf bestimmte Eintrdge in einer Tabelle verweisen. Aus

o diesem Grund werden sie zur VerknUpfung von Tabellen verwendet. Der am
haufigsten verwendete Key ist wahrscheinlich eine id, die jedem Eintrag eine
eindeutige Nummer gibt.

Dann gibt es noch den Sonderfall, dass der Link Uber ein besonders aktiviertes Attribut verlauft. In
diesem Fall handelt es sich um Geodaten. Geodaten sind Daten, die mindestens ein radumliches
Attribut haben. Ein solches raumliches Attribut enthalt in der Regel einen Punkt, eine Linie oder ein
Polygon, es kann aber auch eine Postleitzahl, ein geografischer Name, ein Geohash-Code oder ein
anderer geografischer Code sein.

Klassifikation

Die Klassifizierung ist ein wichtiges Hilfsmittel fir das Verstandnis frisch gewonnener Daten.
Informationen allein reichen nicht aus, um Daten zu interpretieren. Deshalb klassifizieren wir Daten.

Datentypen

Ein Datentyp bestimmt den zuldssigen Wertebereich eines Attributs. Beispiele fur Datentypen sind
text oder integer. Und ein typischer Wertebereich einer vierstelligen Ganzzahl - wie etwa eine
Schweizer Postleitzahl, die von 1000 bis 9999 reicht.

Die folgenden Datentypen sind typischerweise fur die Verknipfung geeignet, aber naturlich gibt es
noch mehr Méglichkeiten:

* Ganzzahl (Integer). Ganzzahlen werden oft zur Verknupfung von Tabellen verwendet. Sie kénnen
zum Beispiel als ID verwendet werden.

* String. Auch Texte kdnnen zur Verknupfung von Tabellen verwendet werden. Sie kdnnen zum
Beispiel einen Namen als Schltsselwert verwenden.



* Date (z.B. Datum IS0-8601 wie 2022-04-01). Ein Tagesdatum bietet sich auch selbst als Schlussel ftr
die Verknupfung an. Auf diese Weise kénnen Sie Daten nach Zeit aufschlusseln.

Zwei Tabellen verknuipfen ("joinen")

Bei der Verknupfung von zwei Tabellen will man Daten aus einer Tabelle mit passenden Daten aus
einer anderen Tabelle verbinden. Zu diesem Zweck definiert man eine Verbindung zwischen den
beiden Tabellen, die aus jeweils einer Spalte der beiden Tabellen besteht. Diese gleiche Spalte muss
nicht den gleichen Namen haben, aber sie muss den gleichen Datentyp haben. Durch die
VerknUpfung kdnnen neue Erkenntnisse Uber die ursprunglichen Daten gewonnen werden.

Im folgenden Beispiel kdnnen die beiden Tabellen verknutpft bzw. verbunden werden, weil sie das
gemeinsame Attribut country haben. Wir kdnnen diese Spalte als Primarschltssel verwenden. In
diesem Fall ist der Datentyp des Schlussels, der zur VerknUipfung der beiden Tabellen verwendet
wird, ein string.

Beziehungen
(Country [profic
Switzerland +41 Switzerland 8637000
France +33 France 67390°'000
Germany +49 Germany 83'240°000

Abbildung 1. Diese beiden Tabellen kbnnen tiber country verbunden werden, da dies ein gemeinsames Attribut
der beiden Tabellen ist.

Zwischen zwei Tabellen kénnen die Daten in einer der folgenden besonderen Beziehungen
zueinander stehen:

* one-to-one (1:1)
* one-to-many (1:n)

* many-to-many (n:m)

One-to-One und One-to-Many werden spéater in der Ubung verwendet werden.

One-to-one (1:1)

Country Flag
m French Flag

Abbildung 2. Jedes Land zeigt auf genau eine Flagge und umgekehrt.



One-to-one bedeutet, dass jede Zeile in der ersten Tabelle mit einer einzigen entsprechenden Zeile in
der zweiten Tabelle verknupft ist. Zum Beispiel hat jedes Land eine Flagge, die es reprasentiert. Im
Gegenzug ist jede Flagge mit einem bestimmten Land verknupft.

One-to-many (1:n)

Country City

Abbildung 3. Ein Land kann auf mehrere Stadte verweisen, aber eine Stadt kann nur auf ein Land verweisen.

Zum Beispiel kann jedes Land mehrere Landessprachen haben (z.B. die Schweiz). Umgekehrt kann
eine Sprache die Landessprache mehrerer Lander sein (z.B. Franzosisch).

o Es ist wichtig zu wissen, dass zwei gleichnamige Stadte nicht als "dieselbe" Stadt
gelten.

Many-to-many (n:m)

Country National Language
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Abbildung 4. Ein Land kann auf mehr als eine Nationalsprache verweisen. Eine Nationalsprache kann auch
auf mehrere Léander verweisen.

Terminologie

Im Folgenden werden einige Begriffe zum besseren Verstandnis noch einmal erklart:

* Tabelle - eine Tabelle ist eine Sammlung von zusammenhangenden Informationen, die in einem

Format mit Spalten und Zeilen gespeichert werden. Tabellen sind Grundstrukturen von
Datenbanken.

* Attribut - eine Komponente einer Tabelle, meist ist es das Feld, das ein bestimmtes Merkmal des
Datensatzes beschreibt.

« Record - Zeile der Datentabelle.



* Join Operation - Prozess, bei dem die Felder einer Tabelle mit denen einer anderen Tabelle auf
der Grundlage eines gemeinsamen Attributs verbunden werden.

+ Datenklassifizierung - Prozess der Gruppierung von Datenreihen in sinnvolle Kategorien, um
die Interpretation zu verbessern.

3. Ubungen

In diesem Teil geht es darum, das Verbinden von Tabellen zu Uben. Das Ziel ist es, weitere Attribute
an eine bestehende Tabelle in der Raumdaten gespeichert sind, anzuhangen. Die neu erstellte Ebene
kann gespeichert werden, wodurch eine neue Datei entsteht, oder sie kann verworfen werden, wenn
sie nicht zufriedenstellend ist oder nicht weiter gebraucht wird.

Ubung 1.1 - Informationssammlung tber Join

In dieser Ubung werden wir den Prozess der Verkniipfung von Tabellen durchgehen, um so viel
Wissen wie moglich aus numerischen Mengen zu sammeln.

Folgende Daten werden fir diese Ubung benétigt:

* World_Countries.gpkg
* C02_Lesungen_Welt.xLsx
* Weltbank_Lander.x1sx

Hier bestehen die numerischen Daten aus CO2-Emissionswerten pro Land, die in einer MS Excel-
Tabelle gespeichert sind. Der Kontext wird durch eine andere Datei bereitgestellt, die eine Liste der
Bevdlkerung jedes Landes enthalt. Das Projekt, mit dem wir arbeiten, hat eine Liste von Lander der
Welt. Jede dieser Dateien enthdlt nur eine kleine Information. Nach der Zusammenfuhrung dieser
Datensatze liefern sie angereicherte und interpretierbare Daten. In diesem Fall waren das die CO2-
Emissionen und die Bevolkerung aller Lander in einem raumlichen Format.

Die Bevolkerungszahl eines Landes kann eine Erklarung fur seine hohen bzw. niedrigen CO2-
Emissionen sein. Wenn wir mit der Erstellung dieser neuen, grésseren Tabelle fertig sind, gehen wir
zum zweiten Teil dieser Ubung Uber: der Datenklassifizierung. Dort werden wir die Daten in relevante
Kategorien gruppieren, um die Interpretation noch weiter zu verbessern.

Heruntergeladene Daten kdnnen bereits eine raumliche Komponente enthalten, wie z.B. die
Bevolkerungszahl in verschiedenen Stadten, aber um die Daten in QGIS zu verwenden, mussen sie
mit dem bereits vorhandenen Datensatz verbunden werden. An dieser Stelle bietet sich das
Verbinden von Tabellen an, da beide Datendateien miteinander verbunden werden kénnen, um
mehr Informationen zu erhalten.

1. Offne QGIS und wihle im Projekt Project » New, um ein neues QGIS-Projekt zu erstellen.

2. Flge die Datei World_Countries.gpkg zum Projekt hinzu, indem du sie von ihrem Speicherort auf
den Ebenenbereich auf der linken Seite des QGIS Editors ziehst.
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Abbildung 5. So sollte alles aussehen, nachdem Wor1d_Countries.gpkg importiert wurde.

. Um die Attributtabelle der soeben importierten Ebene zu prufen, klicke mit der rechten
Maustaste darauf und wahle: open attribute table
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1 g:? Zoom to Layer

. Zoom to Selection
Show in Overview
|| Show Feature Count

Copy Layer

Rename Layer

] Duplicate Layer
[l Remove Layer...

B Open Attribute Table
J/ Toggle Editing
Filter...
Change Data Source...

Set Layer Scale Visibility...
Layer CRS

Export

Styles

Properties...

Abbildung 6. Kontextmenii zum Offnen der Attributtabelle

Du solltest nun die Daten aus World_Countries.gpkg sehen kénnen. Es sollte drei Spalten geben:
REGION, NAME_12 & C_NAME.
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REGION NAME_12 C_Mame =

1 |Asia Afghanistan Afghanistan

2 |Europe Albania Albania

3 |MorthAfrica Algeria Algeria

4 | Sub Saharan Af.. Angola Angola

5 |Caribbean Antigua and Ba... Antigua and Ba...

6 |Latin America Argentina Argentina

7 Asia Armenia Armenia

8 | Australia Australia Australia

9 | Europe Austria Austria

10 |Asia Azerbaijan Azerbaijan

11 | Caribbean Bahamas Bahamas

12 |Asia Bahrain Bahrain

13 |Asia Bangladesh Bangladesh

14 | Caribbean Barbados Barbados

15 |Europe Belarus Belarus

16 Belgium Belgium

T Show All Features _

Abbildung 7. Attributtabelle, die die Daten aus World_Countries.gpkg anzeigt

4. Schliesse die Attributtabelle.

5. Jetzt kénnen wir zusatzliche Daten zu den Landern hinzufigen. Klicke auf: Layers »
Datenquellenmanager



() *Untitled Project — QGIS
Project Edit View

TEm B R E

[P Settings Plugin: Vector Raster Dstabase

+ Data Source Manager Chrl+L

Create Layer »

v

Be V. L Add Layer »
B~ M T Embed Layers and Groups...

Layers Add from Layer Definition File...

[« = T & o copySyle

[IONRRS | PasteStyle

Copy Layer

=

Paste Layer/Group
*% Open Attribute Table F6

=

Toggle Editing
Save Layer Edits
Current Edits »
Save As...
Save As Layer Definition File...
[] Remove Layer/Group Ctrl+D
L] Duplicate Layer(s)
Set Scale Visibility of Layer(s)
Set CRS of Layer(s) Ctrl+Shift+C
Set Project CRS from Layer
Layer Properties..,
Filter... Ctrl+F
= Labeling
3 Show in Overview

o0 Show Allin Overview

% Hide All from Overview

Abbildung 8. Kontextmenii zum Offnen des Data Source Manager.

6. Wahle im Data source manager die Option Browser in der Seitenleiste, um deine
Ordnerstruktur anzuzeigen. Suche den Ordner, in dem du (02_Readings_World.x1lsx gespeichert
hast:

() Data Source Manager — Browser

B Browser Browser
— e THTO

bl E data

Vector

E CO2_Readings_World.xlsx
RenewableEnergy_Percentages.csv
= World_Countries.dbf
¥ ¥ = world_countries.gpkg

Delirmited Worldbank_Countries.xlsx:

Raster

_4 / Mesh

Abbildung 9. QGIS’s Data Source Manager

Doppelklicke auf die Datei, um sie zu den Ebenen in deinem Projekt hinzuzufigen. Danach kannst
du den Data Source Manager schliessen.
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Abbildung 10. Die Datei C02_Readings_World.x1sx wurde zur Erstellung einer neuen Ebene verwendet.

7. Klicke mit der rechten Maustaste auf die neu hinzugefligte Ebene und 6ffne deine Attribute.
Erkunde die Daten, um dich mit ihnen vertraut zu machen.

8. Schliesse die Attributtabelle.

9. Klicke mit der rechten Maustaste auf das Fenster World_Countries layer > Properties > Layer
Properties:
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Path R [ = = kiop\data\world countries.gpkg

Source R [ - : ko p/dataworld_countries.gpkg|layername=world_countries
- Storage GPKG

Comment
- Encoding UTF-8

Geometry Polygon [MultiPolygaon)

CRS EPSG:4326 - WGS 84 - Geographic

Extent -180.0001831054690058,-55.7205696105957031 : 180.0000000000000000,83.6230316162108949%
- Unit degrees

Feature count 132

SHEDHABENSBNS

Identification

Abbildung 11. Fenster Ebeneneigenschaften.

10. Um die Joins fur die Tabelle zu konfigurieren, wahle in der Seitenleiste Joins.
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Abbildung 12. joins in der Seitenleiste der Ebeneneigenschaften

11. Klicke auf das griine Symbol [+] in der unteren linken Ecke des Fensters "Join". Dadurch wird das
Fenster Add Vector Join getffnet.

12. Wahle das Attribut C_Name im Menl Join verbinden und Target Field. Aktiviere das
Kontrollkastchen Custom field name prefix und fige den Typ "joined" in das Textfeld ein.

10



() Add Vector Join

>
Join layer C0O2Z Readings_World Tabelle1 -
Join field abc C_Mame -
Target field abc C_Mame -

¥ | Cache join layer in memaory
Create attribute index on join field
Drymamic farm

] Editable join layer

] Joined fields

w v Custom field name prefix

joined_C0OZ2_Readings_World Tabelle1_

| OK | Cancel

Abbildung 13. Alle Attribute wurden ausgewdhlt und der neue Name wurde vergeben.

Klicke auf [ OK 1.

13. Erweitere die Liste, indem du auf das schwarze Dreieck neben Ebene verbinden klickst, um die
Zusammenfassung der Operation zu sehen.
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14.

15.

Q Layer Properties — world_countries — Joins

Setting

~ Join layer
Jein field
Target field

Dynamic form

Editable join layer

Upsert on edit

Delete cascade

Custom field name prefix

Value

C02_Readings_World Tabelle1
C_Mame
C_MName

Cache join layer in virtual memory +

Jeined_CO2_Readings_World Tabellel_

Joined fields all
& =]/
Style b (0]4 | Cancel Apply Help
Abbildung 14. Die Zusammenfassung der Operation "Tabelle verbinden".
Klicke auf [ OK 1.
Offne erneut die Attributtabelle der Ebene World_Countries.
Layers @
b Im @, Y EU ~ &b & Il
C02_Readings_World Tabelle1 [209]
v . world countries
(2} world_countries — Features Total: 192, Filtered: 192, Selected: 0
J > g L T E QD ¥ E = F &
fid REGIOM MAME_12 C_Mame joined_CO02_Readings_World Tabelle1_C0O2 =
1 175 Caribbean Turks and Caic...  Turks and Caic.., 38880
2 90 Asia Kiribati Kiribati 43690
3 53 Latin America Falkland Islands... Falkland Islands... 45780
4 46 Caribbean Dominica Dominica 141200
5 183 Asia Vanuatu Vanuatu 146500
6 187 Pacific Samoa Samoa 147400
7 37 Sub 5aharan Af... Comoros Comaoros 149600
] 143 Sub Saharan Af... Saoc Tomeand.. SaoTomeand.. 150300
] 170 Pacific Tonga Tenga 155000
10 32 Sub 5aharan &f... Central African ... Central African ... 227400

Abbildung 15. Neue verbundene Attributtabelle der Ebene World_Countries

Wiederhole die Schritte

5
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und fuge

eine weitere Tabellenkalkulationsdatei:

Worldbank_Countries.xlsx zum Projekt hinzu und verbinde die Tabellen unter Verwendung des

Feldnamens als Verbindung.

16. Die neuen Tabellen werden vortbergehend im Projekt gespeichert. Um sie auf der Festplatte zu

12

speichern, klicke auf World_Countries layer » Export » Save Features as ...
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world copmass
g:.-' Zoom to Layer

Zoom to Selection

Show in Overview

|| Show Feature Count
Copy Layer

Rename Layer

L] Duplicate Layer
[[] Remove Layer...
Move to Top
%] Open Attribute Table
// Toggle Editing
Filter...
Change Data Source...
Set Layer Scale Visibility...
Layer CRS
Save Features As...

Save Selected Features As...

Styles
Properties... Save as Layer Definition File...

Save as QGI5 Layer Style File...

Abbildung 16. Wie wird die neue Ebene der verbundenen Tabellen gespeichert?
Wahle GeoPackage als Format.

Setze den Dateinamen auf world _countries_co2.

(&) Save Vector Layer as... x
Format |GeoPad<age - |
File name |warld_countries_co25 €& | |:|

Layer name |wcr|d_countries_::o25 |

CRS | EPSG:4326 - WGS 84 - | |§|

Encoding UTF-5 b
|:| Save only selected features
P Select fields to export and their export options

Add saved file to map l oK J | Cancel | | Help

Abbildung 17. Einstellungen zum Speichern des neuen GeoPackages.

Uberprife, ob Add saved file to map angekreuzt ist. Wenn das Hakchen gesetzt ist, kannst du
fortfahren, indem du auf [OK] klickst. Die Meldung auf dem grinen Feld: "Layer export:
Successful" sollte oberhalb der Karte im Hauptfenster zu sehen sein.

17. Entferne die ursprunglichen Ebenen World_Countries, CO2_Readings_World und
Worldbank_Countries. Klicke auf jede Ebene und wahle: [ Remove layer ].

18. Du kannst das Projekt nun in deinem Ordner speichern.
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Ubung 1.2 - Weitere Ubung des Zusammenfiigens

Jetzt kannst du selbst versuchen, Tabellen zu verbinden:

Verbinde die Tabellen aus der Originaltabelle in der Datei World_Countries.gpkg, aber verwende
dieses Mal C02_Readings_World.x1sx. Versuche, die Anleitung nicht als Leitfaden zu verwenden.

4. Ubungen (Bonus-Teil)

Es mag zwar einfach sein, Daten zu erhalten, aber es ist ziemlich schwierig, ihre Bedeutung zu
interpretieren. Deshalb werden wir in diesem Kapitel unsere nun verarbeiteten Daten klassifizieren
und visualisieren. Lass uns also einen Blick darauf werfen, wie man genau das macht; wie man
zusatzliche Informationen aus Tabellendatensatzen herausholen kann.

Ubung 2.1 - Daten mit Farbe klassifizieren

In dieser Ubung werden wir zusammenhingende Daten sichtbar machen, indem wir die Daten mit
Farbe visualisieren.

Die folgenden Daten werden fir diese Ubung benétigt:

* World_Countries.gpkg
* C02_Lesungen_Welt.x1sx
* Weltbank_Ldnder.x1sx

1. Offne das Projekt aus Ubung 1.2 in QGIS:
Nun kannst du entscheiden, welche Option du verwenden mdochtest:

° Project » Open
° Project » Open From oder

° Project » Open Recent (Dies ist die bequemste Option, wenn du in letzter Zeit an deinem
Projekt gearbeitet hast).

2. Offne das Bedienfeld fir die Ebenengestaltung und wéhle als Ziel die Ebene Verbundene
Tabellen.

14
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Abbildung 18. Wo findest du das Layer Styling Panel?

3. Wechsel zum Bedienfeld fur die Ebenengestaltung und lege fest:

o Graduated Renderer

o

Symbolwert auf joined_C02

o

Legendenformat als Standard belassen

o

Farbrampe in eine beliebige Farbe andern

o

Modus auf Gleiche Anzahl (Quantil)

Wenn du fertig bist, klicke auf [ classify] in der unteren linken Ecke des Fensters. Je nach der
von dir gewdhlten Farbe sollte das Ergebnis in etwa so aussehen wie in der folgenden
Abbildung:

L)

Clsses 5

aaaaaaa

Abbildung 19. Result of applying the Equal Count classifier to the C02 value in the joined table
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Layer Styling n

[ world_countries b
q’ = Graduated =
Value 123 joined_CO2_Readings_World Tabelle1_CO2 > || E
Symbaol | -
Legend format | %1 - %2 edsion (€ |5 ¥ Trim
Color ramp - -
Classes Histogram
Symbol ™ Values Legend
v D 38880.00 - 1263000.00 38880 - 1263000
v D 1263000.00 - 5718200.00 1263000 - 5718200
v D 5718200.00 - 24338000.00 5718200 - 24338000
v . 24338000.00 - 112420000.00 24338000 - 112420000
v . 112420000.00 - 8321000000.00 112420000 - 8321000000
| | e | Live update Apply

Abbildung 20. Classification settings in detail

4. Wiederhole Schritt 3 fir den Wert der Weltbevdlkerung. Vergiss nicht, zu einer anderen Farbe zu
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wechseln, sonst kannst du sie nicht mehr von der CO2-Schicht unterscheiden.

LoyerStying L]

Values Legend
000 IR 3~ 12858
T295631.80- STTUGITE0 1295832 - STTO61E
SIT0617.60- 1036882800 5170618 - 10888626
10988628,00- 2052110620 10988228 - 30921165
30921166.20 - 126427000000 20921185 1364270000

Vitvewdate | ooy

Abbildung 21. Result of applying the Equal Count classifier to the world population value in the joined table
Einige Informationen Uber die Datenmodi oder Klassifikatoren fur fortgeschrittene Benutzer:

o Equal count (Quantil):

Stichprobenquantile werden entsprechend den gegebenen Wahrscheinlichkeiten erstellt. Die
kleinste Beobachtung wird durch 0 und die grésste durch 1 dargestelit.

> Equal Interval:

Unterteilt den Bereich der Attributwerte in gleich grosse Klassen. Die Anzahl der Klassen wird
vom Benutzer festgelegt. Die Klassifizierungsmethode des gleichen Intervalls eignet sich am
besten fur kontinuierliche Datensatze wie Niederschlag, Temperatur oder Bevélkerung.



> Logarithmic Scale:

Eine Methode, um numerische Daten Uber einen sehr grossen Wertebereich kompakt
darzustellen - typischerweise sind die grossten Zahlen in den Daten Hunderte oder sogar
Tausende Male grdsser als die kleinsten Zahlen.

- Natural Breaks (Jenks):

Jenks ist eine Art "optimales" Klassifizierungsschema, das Klassenunterbrechungen findet, die
(fur eine gegebene Anzahl von Klassen) die Varianz innerhalb der Klasse minimieren und den
Unterschied zwischen den Klassen maximieren.

> Pretty Breaks:

Rundet jeden Trennungspunkt auf oder ab. Anstatt eines Bruchpunkts bei 599,85 wird er also
bei 600,00 gesetzt

- Standard Deviation:

Ermittelt den Mittelwert und platziert dann die Klassenunterbrechungen tber und unter dem
Mittelwert in Intervallen von entweder 0,25, 0,5 oder 1 Standardabweichung, bis alle
Datenwerte in Klassen enthalten sind. Werte, die mehr als drei Standardabweichungen vom
Mittelwert entfernt sind, werden in zwei Klassen zusammengefasst: grosser als und kleiner
als die genannten Standardabweichungen.

5. Du kannst auch die Anzahl der Klassen andern. Findest du die Zahl, die deinem Verstandnis der
Daten am besten entspricht.

Mode | ¥EUMatural Breaks (Jenks) - Classes | 5 =
Classify BB | = Delete Al Advanced -
Abbildung 22. Die Anzahl an Klassen kann unten rechts gefunden werden.

6. Um die Unterschiede zwischen den Daten in verschiedenen Klassen hervorzuheben, ist es
manchmal natzlich, verschiedene Farben zu verwenden. Die Option, die uns dies ermdglicht,
heisst RdBu-Farbrampe:

Klicke auf:

Color ramp color » All Color Ramps > RdBu
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Abbildung 23. RdBu Option
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Abbildung 24. RdBu for 6 classes and Natural Breaks (Jenks) classification mode

| Classes | Histogram

Symbol T Values Legend

v . 38880.00 - 56740000.00 38880 - 56740000

v . 56740000.00 - 199400000.00 56740000 - 199400000

v |:| 195400000.00 - 473400000.00 193400000 - 472400000
v |:| 478400000.00 - 1164000000.00 472400000 - 1164000000
v . 1164000000.00 - 56710000000.00 1164000000 - 56710000000
v . 5610000000.00 - 8321000000.00 5610000000 - 2321000000

Abbildung 25. Default Legende

Gebe in die Legende ein, um die Zeichenfolgen durch Wérter zu ersetzen:

| Classes | Histogram

Symbol ™ Values Legend

v . 38880.00 - 56740000.00 Low emission

v . 56740000.00 - 199400000.00 56740000 - 199400000

v |:| 199400000.00 - 478400000.00 199400000 - 473400000
v |:| 472400000.00 - 1164000000.00 473400000 - 1164000000
v . 1164000000.00 - 5610000000.00 1164000000 - 5610000000
v . 5610000000.00 - 23321000000.00 Very high emission

Abbildung 26. Modifizierte Legende
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Ubung 2.2 - Zuséatzliche Daten verbinden
Im Datenordner finden Sie eine Datei: RenewableEnergy_Percentage.csv

Verwende diese Datei fur zusatzliche Daten, die du in deine Tabelle einfigen musst (wiederhole die
Schritte aus Teil 1 dieses Tutorials). Fuhre die Klassifizierung durch. Beschreibe die Ergebnisse und
erlautere die Verwendung der Anzahl der Klassen und Klassifizierungsmodi, die du gewahlt hast. Die
Verknupfung zusatzlicher Daten wird manchmal auch als Data Enrichment bezeichnet.

5. Fazit und Ausblick

Zusammenfassend lasst sich sagen, dass dieses Tutorial darauf ausgerichtet war, zu erklaren, wie
man tabellarischne Daten verbindet. Das Ziel der Ubungen in QGIS war es, die Methoden
kennenzulernen, die es dem Benutzer ermdglichen, Datentabellen zu verbinden und so neue
Tabellen mit erweitertem Kontext zu erstellen. Die grundlegende Einfuhrung in die verschiedenen
Beziehungen zwischen den Daten, wie one-to-one, one-to-many und many-to-many, kann weiter
studiert werden, um das Wissen Uber Datensatze zu vertiefen. Der Teil, der sich mit der Datenanalyse
befasst, vermittelt die Grundlagen der Datenklassifizierung. Die zusatzlichen Informationen tber die
Klassifizierungsalgorithmen geben einen komfortablen Vorsprung, der von den Schulern individuell
weiter ausgebaut werden kann. Dieses Tutorial dient als Anleitung zum Importieren von Daten in
eine QGIS-Umgebung, zum Zusammenfihren in eine neue Tabelle, zum Klassifizieren und
schliesslich zum Analysieren der Daten.

Die Many-to-many-Beziehung wurde in den Ubungen hier nicht behandelt. Es ist jedoch méglich,
Many-to-many-Beziehungen in QGIS zu verwenden. Wenn du mehr daruber erfahren mdchtest,
kannst du das in: QGIS Doc.

Wenn du mehr uber Joins in Datenbanken und deren Verwendung erfahren mochtest, findest du
weitere Informationen unter dem Stichwort SQL JOIN.

Noch Fragen? Wende dich an OpenStreetMap Schweiz oder Stefan Keller!

STy Frei verwendbar unter CCO 1.0
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https://docs.qgis.org/3.16/en/docs/user_manual/working_with_vector/attribute_table.html#introducing-many-to-many-n-m-relations
mailto:info@osm.ch
mailto:stefan.keller@ost.ch
http://creativecommons.org/publicdomain/zero/1.0/
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